Release Notes for Modo 10.2v1

Copyright © 2016 The Foundry Visionmongers Ltd.

Release Date
13 October 2016

System Requirements
Officially Supported Operating Systems
• Mac OS X 10.9.x, 10.10.x, 10.11.x, and 10.12.x (64-bit only)
• Windows 7, Windows 8, and Windows 10 (64-bit only)
• Linux 64-bit operating system (RHEL 5.4+)

Minimum Hardware Requirements
• Intel processor(s), Core i3 or higher
• 10 GB disk space available for full content installation
• At least 4 GB RAM
• Display with 1920 x 1080 pixel resolution
• Internet connection for product activation and online videos access
• The Advanced viewport mode requires an NVIDIA or AMD graphics card with at least 1 GB of
graphics memory and drivers that support OpenGL 3.2 or higher.

Recommended System Requirements
NOTE: This information is our best recommendation for the average user. Requirements
vary by usage, and individual users may have different requirements from those listed here.
• 2.5+ GHz quad-core processor
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• 250+ GB disk space available for caching and temporary files, SSD is preferable
• 16 GB RAM with additional virtual memory*
• Display with 1920 x 1080 pixel resolution
• An NVIDIA or AMD graphics card with the latest drivers
• 2+ GB of graphics memory
• OpenGL 4.4 or higher support
*The use of virtual memory improves stability and helps prevent data loss on large projects.

Tested Workstation Hardware
The configurations listed below are those that The Foundry have tested with Modo 10.2v1. Due to the
constantly changing nature and wide variety of computer hardware available in the market, The
Foundry is unable to officially certify hardware. The list below can be used as a recommendation and
does not guarantee that it meets your particular needs.
Please download and install the latest graphics driver from the NVIDIA or AMD websites. Make sure
that you are using 8.982.8.1 drivers or higher for AMD cards.
If you encounter any issues, please visit the Support Portal at supportportal.thefoundry.co.uk.
Tested Workstation Hardware
Apple

• MacPro4, 1
• MacPro5, 1
• iMac13, 2
• MacBookPro10, 1
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Tested Workstation Hardware
Dell

• Dell T1700
• Dell T3610
• Dell T3620
• Dell T5810
• Dell T7610
• Dell T7910
• Dell Precision Rack 7910
• Dell Precision 5510
• Dell Precision 7710
• Dell M2800
• Dell M6800

HP

• HP Z440
• HP Z600

Tested GPU Hardware
AMD Prosumer Graphics Cards

• Radeon™ HD 1900 XT
• Radeon™ HD 2400 XT
• Radeon™ HD 2600 Pro
• Radeon™ HD 3870
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Tested GPU Hardware
AMD Enterprise Graphics Cards

• FirePro™ W4170
• FirePro™ W5000
• FirePro™ W8000
• FirePro™ W2100
• FirePro™ W5100
• FirePro™ W4100
• FirePro™ W7100
• FirePro™ W8100
• FirePro™ W9100

NVIDIA Prosumer Graphics Cards

• Geforce GTX 680
• Geforce GTX Titan
• Geforce GT 650M

NVIDIA Enterprise Graphics Cards

• Quadro® K6000
• Quadro® K5000
• Quadro® K4000
• Quadro® K2000
• Quadro® K600
• Quadro® K5200
• Quadro® K4200
• Quadro® K2200
• Quadro® K1200
• Quadro® K620
• Quadro® M5000
• Quadro® M4000
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New Features
Animation
Deformer Caching
The output of mesh operations and deformers can now be cached when animating a scene. When
frames are cached, performance is limited mostly by GPU drawing performance. The Cache
Deformers options greatly improve playback speed, at the expense of using more memory.

Direct Modeling
Curve Tool Improvements
The following improvements have been made to the Curve and Bezier tools:
• Auto Curve Edit - When selecting a curve, the corresponding curve editing tool now automatically
activates, allowing you to immediately start editing the curve.
• Zero-weight Bezier Tangents - You can create sharp corners on Bezier curves by clicking in the
viewport (as opposed to clicking and dragging to create a smooth control point).
• Round Corner Tool - While editing Bezier curves, sharp corners now have a widget you can drag to
add a rounded corner.
• Bezier Tool: Preserve Broken Tangents by Default - You can edit the tangent handles of a Bezier
curve's control point independently.
• Close Curve by Clicking on First Control Point - Right-clicking on the first control point while
creating a new curve closes it into a loop.

File I/O
Redirecting Content
The content location can now be controlled by the config system, making it easier to change where
the content is located. You can set this in Preferences > Defaults > Application > Content Location.
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MeshFusion
Compound Trim Viewport UI
The Schematic-free system utilizes Compound Trims. They are simple assemblies created and
destroyed on the fly as you add Trim geometry consisting of multiple meshes.

Deferred Updates
The Fusion item now has a Deferred Updates checkbox. When enabled, the Fusion item doesn't
update to reflect changes to the input geometry until you release the mouse button. This allows you
to edit very complex setups with reasonable performance.

Fusion Legacy Model Conversion
Previous Fusion models (Schematic or Item List structure used for 3D-Tree Fusions) can be converted
to the new Flat Schematic Tree used by the Schematic-free system. Legacy Fusion models still load
and display properly, conversion is only required for further editing.

Source Mesh N-gon Support
MeshFusion now supports n-gons in source meshes.

Support Standard Transforms of Fusion Item
You can now use the standard Modo transforms to move, rotate, and scale your Fusion Item.

Fusion Tab
MeshFusion's toolbar has been updated with new functionality. Additionally, drag-and-drop
functionality has been added.

Wireframe Drawing of MeshFusion Input Items
MeshFusion input items are now drawn in wireframe mode. This improves clarity in the viewport, and
means MeshFusion no longer creates or requires custom shaders or groups.
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Procedural Modeling
Assembly Aliases
Assemblies can be collapsed into a single Assembly Alias item. This allows more technical artists to
create assemblies that are easier to use for others and makes the scene appear tidier.

Duplicating Geometry
The following procedural mesh operations have been added to Modo:
• Array
• Clone
• Mirror
• Radial Array
• Radial Sweep
• Scatter Clone
• Symmetrize

Slice Tools
The following procedural mesh operations have been added to Modo:
• Axis Drill
• Axis Slice
• Boolean
• Slice
• Solid Drill

Surface Support for Merge Meshes
The Merge Meshes operation has been extended to accept any item with geometry in it, including
MeshFusion items, procedural items, such as the Gear and Rock items, VDBVoxel meshes, the output
from Fabric canvas graphs, and so on.

Selection Modifiers
The following procedural selection modifiers have been added to modify existing selections:
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• Boundary Edges - Converts a polygonal selection into an edge selection by using the boundary of
the polygon selection to determine the edges to select.
• Grow/Shrink - Grows and shrinks the selection.
• Invert - Inverts selection operations.
In addition, selections have blend modes that specify how multiple selections are combined.

Rendering
Mesh Lights
A new light type - Mesh Light - has been added. This new light type allows you to choose a single
mesh item in the scene and use it as the shape of the light.

Sampling Settings
Reflection, refraction, and subsurface scattering (SSS) sample settings have been moved from the
individual materials to a global control on the Render item. If the global setting is 0, the local control
on the materials is still used. Additionally, there is a quality multiplier on the individual materials if
you want to have different quality levels on different materials.

Preview Lock
A new Lock button has been added to the Preview window. When enabled, it completely locks Modo,
preventing you from accidentally restarting preview. Secondly, it overrides all the quality settings to
make sure that everything is set up correctly for final frame rendering.
This makes it much easier to use preview for final frame rendering for stills.

Rounded Edges
Two new properties have been added to the Material item properties:
• Rounded Edge Width - A new Shader Tree effect that allows the widths of rounded edges to be
controlled by image maps, procedural textures, or gradients. The value of a texture using this effect
acts as a multiplier on the edge width specified in the material properties.
• Rounded Edge Angle - A new material channel that controls which edges should appear rounded
based on how sharp they are. An edge appears rounded if the surface normals of the adjoining
polygons vary by more than the Rounded Edge Angle setting. The default value is 40 degrees, same
as the default Smoothing Angle. Lowering the setting to 0 causes all edges to appear rounded.
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Simpler Controls in Render Window
The Image Processing and Compare, Region, and Options tabs in the Render Window have been
tidied up and simplified.

Topology
Automatic Retopology
A new command has been added that generates new mesh items from the selected items. The new
mesh is produced according to an automatic retopology algorithm that aims to output a clean mesh
with good topology at a density you specify. The density can be controlled by Weight Maps or by the
input density and the mesh flow can be controlled by edge selection sets or by sketching guide curves
on the surface. For more information about sketching guide curves, see Retopo Guides.
The automatic retopology implementation converts a mesh into a mesh made up of all 3-, 4-, and 5point polygons of a uniform size. To determine this polygon size, it looks at the number of polygons
you request in the output, and divides the surface of the area by that number. As a result, the target
polygon number, either as a number or a percent, is only approximate. An option to apply a
subdivision to the mesh to produce pure quads is also available.
The retopology algorithm can detect sharp edges in the input mesh and preserve them by looking for
faces that meet at an angle greater than the crease angle you specify. Although the process is
automatic, you can guide the results using standard Modo mesh attributes, like the RetopoDensity
weight map, or the RetopoEdgeLock and RetopoFlow edge selection sets.

Detriangulate
The Detriangulate tool removes diagonal edges. It allows you to control flatness thresholds and to
specify one or mores edges to act as guides for where the quads are.

Retopo Guides
This tool allows you to sketch curves (polylines) on a surface that are set up as either position or edge
flow guides for automatic retopology. The curves are tagged with the special selection set name that
the autoretopo command looks for, and they have a vertex normal map with normals taken from the
surface. These are both necessary elements for autoretopo.
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You can activate the tool by clicking on the Retopo Guides button in the Topology layout under the
Tools sub-tab.

UI
Automatic Component Selection
In Auto Select mode, Modo automatically switches between Vertex, Edge, and Polygon selection
mode, depending on what type of component you click on.

Enable/Disable Camera Images
You can now enable and disable foreground and background images in the Camera item's properties.

Fading Grid
The grid now fades out around the corners, providing a sense of depth and distance. Red and blue
color highlights for the X and Y center axis can also be enabled to help keep your orientation.

Item Mode Wireframe and Selection Drawing
Selected items now always draw their wireframe, even if wireframe display is disabled. Optionally, the
item selection can be drawn with a solid fill instead.

Item Work Planes
To make aligning the Work Plane to items easier, you can now right-click on an item in the 3D
viewport and align the Work Plane to that item.

Morphed Mesh Drawing
Morph maps can be drawn as a cage, with various drawing styles, with vectors drawn as line
segments from the base mesh to the morph mesh, and with color and opacity settings for the morph
cage.
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Primitive Tool Handle
Additional controls have been added for the interactive tools. The tool handles can now either adjust
around a locked central location, or lock the opposite side to the grabbed handle, making them
easier to use.

Proficiency Switching in Forms
Panels that contain controls with different proficiency levels now show Less and More buttons at the
bottom of the view, allowing you to display fewer or more controls.

Vertex Drawing Options
Vertices are now automatically visible in Vertex mode, but not otherwise. They can still be explicitly
enabled in other component modes.

Work Plane Align to Screen
An option to align the work Plane to the Perspective view has been added to make certain modeling
tasks easier, such as drawing curves using Sketch.

Work Plane Bookmarks
Work Plane bookmarks can now be assigned to polygons and re-used later on. This is useful to store
construction planes in the geometry itself. Work Plane Bookmarks work in a way that is very similar
to selection sets. Different bookmarks can be saved for each of your scenes.

Work Plane Visibility Options
New viewport visibility options have been added to provide more control over the main grid and the
Work Plane.
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Miscellaneous
Copy Transforms
The item.copyTransforms command has been added, which copies transforms from one item to
another. Unlike the item.align command, this new command copies all animation and rigging as
well.

Maximum Environment Resolution
A new preference for environment resolution has been added to the Display Preferences. Reducing
the resolution increases performance when editing the environment.

Numeric Control Color Correction
Numeric control color correction applies color correction to the numeric values displayed in color
fields. For example, this allows you to copy and paste the hex code for a color from Photoshop into
Modo and have the colors match. Previously, Modo supported color correction for the drawn
representation of a color in the UI but the numeric values were always drawn in linear space.

Particle ID Channel
Locator items now have a Particle ID channel that can be used to drive the Particle ID assigned to
rendered surfaces. You can set this value manually or drive it by a rig and then feed it to Shaders. This
is mostly useful for Gradients and Texture Switch.

Simulation Modifiers
Simulation Modifiers provide ways to control animated behaviors based on set triggers.

String Encode Modifier
This is a simple channel modifier for turning a numerical value into a text string with optional
decimal precision and leading zeroes.
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Feature Enhancements
• UI: There was no keyboard shortcut to quickly open popovers and to match snapping and
symmetry.
• BUG ID 14167 - Paint layout: You can now undo your settings for Image Set Resolution.
• BUG ID 26856 - Render layout: A Rounded Edge Width has been added as a texture effect in the
Shader Tree.
• BUG ID 31383 - Render layout: A Rounded Edge Angle channel has been added to the advanced
Material item to control which edges should have the rounding effect applied (expressed as the
minimum angle between the surface normals of the adjoining polygons). The default value of 40
degrees matches the default Smoothing Angle.
• BUG ID 31747 - Online Help: The documentation has been updated for Environment Presets,
highlighting the fact that full lighting setups can be stored.
• BUG ID 32703 - Item List: Item filter selection by color has been added.
• BUG ID 47652 - Volumes: The VDBVoxel item has been added to the schematic's Add > Volumes
menu.
• BUG ID 50877 - Procedurals: The ability to apply Curve Fill to pave in axis other than the Z axis has
been added.
• BUG ID 51256 - Procedurals: To improve performance, Mesh Ops are no longer evaluated in the
Setup layout and in Setup mode.
• BUG ID 51262 - GL: Color has been improved in the viewports.
• BUG ID 52354 - File Output FBX: Added functionality for exporting replicators with multiple
prototypes.
• BUG ID 52422 - Item List: Item List > Filter Items > By Color dropdown options now matches the
options in the Item List right-click context menu.
• BUG ID 52463 - Model layout: The command select.all has been added to modo_cl.
• BUG ID 52452 - UI: The VDBVoxel option has been added to the Schematic Preset Browser.
• BUG ID 52455 - Procedurals: The Enable option has been added to the Curve Rebuild operation
Properties.
• BUG ID 52491 - UI: The Mesh Operations list is now consistent between layouts.
• BUG ID 52650 - Shader Tree: The Assign Material command has been updated to display a material
type dropdown menu when a pre-existing material group is selected.
• BUG ID 52651 - Shader Tree: Selecting an existing Unity or Unreal material in the Assign Material
dropdown menu now updates the properties in the dialog.
• BUG ID 53058 - Particles: Spring and Viscosity properties have been added for Dynamic Fluid.
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• BUG ID 53073 - Shader Tree: Normal Map Blend mode has been added to stack normal maps
correctly.
• BUG ID 53117 - Performance: In the Advanced viewport, the minimum GPU RAM specification has
been increased from 512 MB to 1 GB.
• BUG ID 53432 - UI: Tooltips has been added to Preview.

Bug Fixes
• Deformers: Selection drawing wasn't disabled when scrubbing or playing animations.
• File Output: The Unreal export didn't work as expected.
• There was no progress confirmation when re-exporting or overwriting unchanged image files.
• The image map names were missing for warning/handling of non-alphanumeric characters.
• The file names were missing for warning/handling of non-alphanumeric characters.
• File names for images used in the clip view were not captured.
• Export Substance textures was not supported.
• File Output (Game Export): The latest version of the Unreal Modo Material Importer was not
supported.
• File Output: UV Distortion Maps were not filtered out from .fbx files when exported.
• Network Rendering: Rendering with Use Network Nodes Only enabled caused Modo to crash.
• Preview: There were no notification if all buckets had been processed at least once in Preview
Animation.
• Render: Occlusion-based edge rounding was skipped entirely for indirect rays.
• Render: Render performance was slow generating scenes using indirect rays.
• BUG ID 29134 - Shader Tree: Duplicating a nested layer mask created a nested layer mask in the
group mask.
• BUG ID 30312 - Model layout: With Symmetry on, axis transform handles were drawn in the wrong
transformation. For example, the Y axis moved in the X direction and the X axis moved in the Z
direction.
• BUG ID 30417 - Render layout: Moving points on a curve broke continuous implicit UV textures.
• BUG ID 36363 - Shader Tree: Duplicating or copying an instance in the Shader Tree set its effect
incorrectly.
• BUG ID 36881 - Presets: Selecting a material mask, then double-clicking to add presets, loaded them
incorrectly.
• BUG ID 37318 - Model layout: Undoing the workPlane.fitGeometry and workPlane.fitSelect
commands did not work correctly.
• BUG ID 38613 - Sculpt layout: Image-based sculpting sometimes broke meshes along polygon
borders.
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• BUG ID 40167 - Animation layout: Pivot snapping did not work in Skeleton Edit mode.
• BUG ID 41021 - Render layout: Using the Shadow Density render output resulted in high render
times.
• BUG ID 41326 - Deformers: Wrap Deformer did not respond to deformations on the wrap mesh.
• BUG ID 41743 - File Output: When exporting Alembic format data files, unit distances were not
preserved.
• BUG ID 42163 - Shader Tree: Blending between two masks (material presets), and altering the
properties of the topmost mask, did not blend results correctly.
• BUG ID 42391 - Dynamics: Closed polylines were simulated as if opened.
• BUG ID 43736 - File Input: Importing Alembic format data files changed the scene to 24 fps.
• BUG ID 44616 - File Output: When using Export Selected Layers, Modo crashed exporting layers to
separate files.
• BUG ID 44732 - Preview: Autofocus (Ctrl/Cmd+F) did not work in full-resolution mode.
• BUG ID 45172 - GL: Performance - Zooming in and out, with the mouse in a dense scene,
sometimes caused a lag.
• BUG ID 45847 - Volumes: VDBVoxel motion blur didn't orient properly.
• BUG ID 46732 - File Input: Vertex maps without a name could not be selected.
• BUG ID 46781 - UI: Dragging the render camera label sometimes caused Modo to crash.
• BUG ID 47134 - Network Rendering: If the last frame was rendered on a slave system, the Render
window didn't show it.
• BUG ID 47230 - File Output: Export of Alembic format data files failed due to a custom channel
called inherit.
• BUG ID 47636 - File Output: Export of Alembic format data files failed to include User channels.
• BUG ID 47909 - UI: Editing the Work Plane made it visible, even when its visibility was disabled.
• BUG ID 47916 - File Output: Export of Alembic format data files failed if the scene FPS was not set.
• BUG ID 48187- Dynamics: Compound Rigid Body Glue did not work.
• BUG ID 48495 - File Output: Exporting unsupported face types in Alembic format data files caused
Modo to crash.
• BUG ID 48630 - UI: The command query button worked as a toggle in most forms but not in Pie
menus.
• BUG ID 48669 - UI Linux only: Meshfusion object set to Airtight Final crashed Modo when Dup &
Convert to Mesh was applied.
• BUG ID 48724 - Preview: A maximized Preview failed to update keyed color changes when switching
frames.
• BUG ID 48793 - Animation layout: Animation Baking did not work with Dynamic Parenting.
• BUG ID 48952 - Performance: Working on FBX scenes or objects which were imported with high
values for scaling causes extreme GUI lags.
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• BUG ID 49304 - UI Linux only: Selecting None for the camera's background image caused Modo to
crash.
• BUG ID 49440 - UI Mac: Target filenames were not displayed in the missing file dialog.
• BUG ID 49810 - GL: In the Advanced viewport, a negative scale of an object displayed as flipped
polygons.
• BUG ID 49857 - Deformers: Lattice deformation smoothing was incorrect.
• BUG ID 50208 - Shader Tree: Using a procedural material as a Layer Mask rendered incorrectly until
disabling and re-enabling the layer above it.
• BUG ID 50412 - Schematic: Assembly values were not saved and reloaded with specific scenes.
• BUG ID 50459 - UI Linux: Popover windows did not display when activated.
• BUG ID 50601 - File Input: Importing .obj files with the material Diffuse set to 0%, produced black
textures.
• BUG ID 50623 - Volumes: Preview didn't respond to feature parameter changes made to VDBVoxel
items.
• BUG ID 50629 - GL: Changing the Preference > Color Management > Change Default View
Colorspace setting with the Advanced viewport active caused Modo to crash.
• BUG ID 50634 - Preview: Editing the material of an invisible item made it visible.
• BUG ID 50657 - Procedurals: Translating procedural meshes was slow.
• BUG ID 50684 - Deformers: The Lattice deformer did not work correctly in some cases.
• BUG ID 50789 - GL: In the Advanced viewport, Screen Space Ambient Occlusion (SSAO) caused a
memory leak.
• BUG ID 50802 - Volumes: Blobs didn't render in Preview with a Particle Source and Orthographic
Camera.
• BUG ID 51015 - UI: Shift + right-clicking 3D Selection Add did not work, but Alt + right-clicking did,
when in Maya navigation remapping.
• BUG ID 51021 - Model layout: The Text tool's Font menu only displayed the first member of font
families.
• BUG ID 51174 - GL: When started in Play mode, there was no indication that Play mode was active.
• BUG ID 51292 - Model layout: Using the Bevel or Inset tool caused shading issues for all polygons
that had holding edges for holes.
• BUG ID 51298 - File Input: Modo either crashed or displayed the error message Scene load
unsuccessful when importing a specific Alembic format data file.
• BUG ID 51332 - Model layout: Make Curve Fill didn't work as expected.
• BUG ID 51397 - Render layout: Round Edge Shader didn't work in certain situations.
• BUG ID 51401 - Render layout: Loading a .png file into the Render Window did not work as
expected.
• BUG ID 51424 - Fusion: Alt+N and Alt+M produced errors when a non-Fusion item was selected.
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• BUG ID 51443 - GL: The Environment Map was flipped in Advanced viewport orthographic views.
• BUG ID 51450 - Model layout: The MeshFusion trim tool produced unexpected results and displayed
jagged edges where the mesh quads were cut off.
• BUG ID 51452 - Model layout: The MeshFusion trim tool displayed jagged edges.
• BUG ID 51513 - Animation layout: The Camera Matching Line length control wasn't accurate and did
not match the geometry to an image.
• BUG ID 51529 - GL: Environment reflection did not work correctly in orthogonal viewports.
• BUG ID 51554 - GL: The Advanced viewport roughness did not match Modo's render with Imagebased lighting (IBL).
• BUG ID 51686 - Model layout: Drawing a curve in the base mesh in the procedural with Merge
Meshes and Polygon Reduce operations caused Modo to crash.
• BUG ID 51695 - Render layout: Baking a UDIM bake item with save output for .png formats created
corrupted saved images.
• BUG ID 51772 - GL: The Default and Orthographic views of the Model layout displayed artifacts.
• BUG ID 51809 - Schematic: Closing a scene after using select.link with no arguments caused Modo
to crash.
• BUG ID 51865 - Model layout: Procedural tool handles sometimes severely affected viewport
performance.
• BUG ID 51957 - GL: Using a GL background with Gradient set in an Orthographic view looked
incorrect.
• BUG ID 52068 - Dynamics: Mesh Shatter source mode created shards incorrectly.
• BUG ID 52081 - Particles: Particle Modifiers using a mesh as an input Point Source changed the
particle color to black.
• BUG ID 52240 - Render layout: Texture Replicators did not work correctly on vertical surfaces.
• BUG ID 52246 - Model layout: The Polygon Extrude mesh operation only worked when the axis was
set to none.
• BUG ID 52247 - Shader Tree: The Particle ID list displayed Material IDs.
• BUG ID 52249 - File Input: Using the Image tab Add button to make a new image group failed.
• BUG ID 52258 - Sculpting layout: Cutting and pasting part of a multi-resolution sculpt mesh
removed sculpting on the part of the mesh that was not cut.
• BUG ID 52290 - UI: Environment images didn't appear in the Images tab when loading scenes with
those clips parented.
• BUG ID 52297 - Scripting: The NEXUS_SCRIPTS environment variable did not change the location for
implicit scripts run with @.
• BUG ID 52320 - Preview: Volume items did not display the alpha output in Preview.
• BUG ID 52321 - Sculpting layout: Unsupported falloff input options remained in the Sculpt Modifiers
menu.
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• BUG ID 52325 - Model layout: Copying and pasting a closed curve caused the pasted curve item to
have a sharp start/end point.
• BUG ID 52334 - Mesh Types: Using the poly.convert command on curves produced unexpected
results.
• BUG ID 52364 - Model layout: The Extrude and Bevel mesh operations sometimes caused Modo to
become unresponsive when used on a frozen Text item.
• BUG ID 52381 - Preview did not updated correctly when visibility changed on an Item Shader.
• BUG ID 52389 - Preview: Deleting a Cel Edges material while Preview was running caused Modo to
crash.
• BUG ID 52399 - Model layout: After having a Freeze mesh operation in the stack, any change to the
Subdivision Level of the base mesh didn't update until you disabled and re-enabled the Freeze mesh
operation.
• BUG ID 52403 - Shader Tree: Deleting a Shader mask caused Modo to crash or become
unresponsive.
• BUG ID 52407 - Preview: Changing the convergence slider relaunched Preview.
• BUG ID 52411 - Model layout: The Radial Array Merge Vertices option only merged vertices with the
source geometry.
• BUG ID 52415 - Render layout: Bump maps couldn't be baked from a mesh.
• BUG ID 52423 - Model layout: Freezing subdivisions to quads with the Freeze mesh operation did
not update when changing subdivision level on the mesh.
• BUG ID 52442 - Model layout: The Tube tool sometimes crashed if you tried to select a non-existent
preset by using a script or command.
• BUG ID 52445 - Procedurals: A scene containing a hidden procedural mesh took a long time to
open.
• BUG ID 52470 - Model layout: Modo became unresponsive when adding a Polygon Bevel Mesh
Operation to a specific item.
• BUG ID 52480 - GL: After disabling GL visibility performance checkboxes with the Advanced
viewport active Modo crashed.
• BUG ID 52484 - Preview: When changing the Render Curve Start value while running Preview Modo
crashed.
• BUG ID 52487 - Deformers: The Add Item buttons in the Mesh Operations list and in the Item List
displayed the same name.
• BUG ID 52488 - Deformers: The Add Item list in the Mesh Operations list and in the Schematic
viewport displayed as Procedural in the menu.
• BUG ID 52490 - UI: Some deformers had no buttons in the Setup layout toolbar.
• BUG ID 52498 - Animation: A customer project was performing significantly slower in Modo 10.1
than in Modo 10.0.
• BUG ID 52500 - UI: No Apply button was displayed in the Edge Slide tool properties.
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• BUG ID 52503 - Scripting: Using a command alias for mesh cleanup caused Modo to crash.
• BUG ID 52515 - Model layout: Running the Mesh Cleanup or Merge Vertices commands on specific
meshes caused Modo to crash.
• BUG ID 52528 - Render layout: When rendering a specific scene after deleting the B-spline Weight
Map Modo crashed.
• BUG ID 52539 - Model layout: Deleting a Weight Map with transparent materials caused Modo to
crash.
• BUG ID 52553 - Render layout: When using standard scene lights with negative intensity values, a
clipped patch of black was displayed.
• BUG ID 52556 - UI: Some area light flags were disabled but were still needed if the falloff type was
changed.
• BUG ID 52563 - Shader Tree: Two Texture Locators were created when Final Color output was
defined using the Bake Wizard.
• BUG ID 52567 - Deformers: The Deformer List showed graphs ordered in the opposite order to the
Schematic.
• BUG ID 52582 - Render: The Render Output Bake item didn't save to an output directory driven by a
String Constant node.
• BUG ID 52583 - Render layout: Render failures occurred using Bake items.
• BUG ID 52584 - Preview: Adjusting Occlusion Texture cache settings with Preview running caused
Modo to crash.
• BUG ID 52585 - Model layout: Copying procedural items from one scene to another didn't work.
• BUG ID 52586 - Model layout: The Procedural Lattice Effector crashed when scaling lattice points.
• BUG ID 52599 - Deformers: Polygon rollover highlighting was incorrect for deformed meshes.
• BUG ID 52610 - UI: Texture falloff XYZ was only visible when the Locator was selected.
• BUG ID 52621 - Scripting: Trying to remove an item when the value was set to None
(scene.removeItems(None)) caused Modo to crash.
• BUG ID 52633 - Shader Tree: Texture Replicators did not align to particles.
• BUG ID 52644 - Volumes: Navigating Preview with VDBVoxel items was much slower in Modo 10.1v2.
• BUG ID 52645 - Model layout: The Right-click Lasso selected more than expected.
• BUG ID 52656 - Model layout: UV data was lost when freezing a procedural item.
• BUG ID 52660 - Model layout: modo_cl crashed when running the poly.freeze command on curves
with Tessellation set to false.
• BUG ID 52665 - Model layout: New materials were not created when copying and pasting polygons
into a new scene.
• BUG ID 52668 - Preview: Right-clicking in Preview showed item masks multiple times.
• BUG ID 52688 - UI: Profile names in the Preset Browser displayed the file path instead of the name.
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• BUG ID 52701 - Animation: The Command Region command entry field displayed the command
name, not the command.
• BUG ID 52709 - File Input: Loading a scene with a corrupt .png image caused Modo to crash.
• BUG ID 52748 - Particles: When using a UV Constraint in a Particle Simulation Modo crashed.
• BUG ID 52786 - Item List: Mesh item visibility couldn't be enabled in Element mode.
• BUG ID 52793 - Paint layout: Flipping image inks created repeats, even if Repeat was disabled.
• BUG ID 52814 - GL: Polygon selection only worked on selected items.
• BUG ID 52826 - Procedurals: Selecting the base mesh and adding an operator placed it in the wrong
location in the stack, instead of immediately above the base mesh.
• BUG ID 52830 - Model: Right-clicking on selected edges after beveling caused Modo to crash.
• BUG ID 52857 - Shader: Tree UV mapping was not working correctly with the Texture Switch node.
• BUG ID 52858 - Shader Tree: Modo allowed Particle IDs to be 1.0 (previously, any ID >= 1 was set to
0) for the Texture Switch node. It added the username for the Particle ID channel.
• BUG ID 52860 - Content: Closing a scene with a SLIK2 Studio preset in it caused Modo to crash.
• BUG ID 52889 - UV: Using Bevel with Inset and Make UVs Connected broke the UVs.
• BUG ID 52893 - UV: Copying and pasting from the UV lists tab sometimes broke UVs.
• BUG ID 52899 - Procedurals: New mesh operations were always added to the top of the Mesh
Operations list.
• BUG ID 52940 - Deformers: Lattice points set up with Item Influence crashed when used as a
Replicator prototype.
• BUG ID 52969 - Deformers: Tools were not respecting the Enable Deformers option setting in the
viewport.
• BUG ID 53131 - Procedurals: The Path Generator tool operation flipped polygons.
• BUG ID 53134 - Shader Tree: Dragging and dropping an item into a new scene reordered all
associated shaders.
• BUG ID 53137 - Preview: Replicators could not be deselected.
• BUG ID 53172 - File Import: Loading an .fbx file with a user-defined channel name caused Modo to
crash.
• BUG ID 53194 - Network Rendering: Image processing was not possible and dummy thumbnail
images were generated for offloaded (slave-only) renders after the 10th render.
• BUG ID 53207 - File Output: Saving Substance images sometimes caused Modo to crash.
• BUG ID 53219 - Schematic: When dragging materials from one file to the other, all schematic links
were lost.
• BUG ID 53229 - UI: The Time Offset Type channel had a dropdown menu with incorrect entries.
• BUG ID 53248 - File Output: Alembic format data files crashed or hung when exporting a procedural
mesh with a Bevel mesh operation.
• BUG ID 53457 - UV: Selecting the next loop on a UV map caused Modo to crash.
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Known Issues and Workarounds
This section covers known issues and gives workarounds for them, where appropriate.

Advanced Viewport
• BUG ID 50810 - Anisotropic texture filtering is lower quality than in the Default viewport.
• BUG ID 50364 - The Advanced viewport shows visible seams or noise after using environment
textures.
• BUG ID 49598 - Spurious diagonal lines of bad pixels may appear in the Advanced viewport with
some AMD cards.
• BUG ID 46995 - Ambient Occlusion display in the Advanced viewport is affected by selected item
wireframes.
You can disable Show Selection in the Visibility options or disable wireframe drawing on the active
mesh layers.

Assemblies
• BUG ID 36452 - Assemblies exported from the Item List context menu result in poor visual layout of
nodes on import.
As a workaround, you can save assemblies from the Schematic viewport.

Audio
• BUG ID 52242 - Windows only: The .au format doesn't load on Windows 10, due to the lack of
DirectShow support, which Modo uses, for the format.
As a workaround, convert the audio file to a different format, such as .wav. This bug will not be
fixed.

Baking
• BUG ID 50671 - Baking displacement maps can cause UV seams to be visible, and the baked
displacement map to show quilting effects and other render artifacts.
• BUG ID 49437 - The Bake Channel Swizzling option can’t bake to texture alpha.

Color Management
• BUG ID 49244 - Windows only: With Perform Color Correction on, setting a default scene to a
scene with a mesh that has a position channel crashes Modo at launch.
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As a workaround, use System > Reset Preferences to reset to defaults or move/remove the default
scene.

Default Viewport
• RGBA textures only draw correctly in the Advanced viewport. In the Default viewport, any
unsupported texture effect on an image map is drawn as diffuse color when the layer is selected in
the Shader Tree.

File and Image I/O
• BUG ID 53498 - Mac OS X only: Export Selected Layers may cause Modo to crash on some systems.
As a workaround, copy the mesh you want to export to a new scene and save it from there.
• BUG ID 50198 - Alembic scenes don't export some surface items, including static meshes and
procedural shatter items.
• BUG ID 49728 - Exporting selected layers (from the Item List context menu) to .fbx doesn't export
instances unless the original mesh is also exported.
To resolve this, set the .fbx preference to Export Selection and use Export As….
• BUG ID 47036 - Color management in .svg images is not currently supported. This is a side-effect of
a bug fix where the largest allowable image size (64k x 64k) was always used when color correction
was enabled.
• BUG ID 46962 - Rendering .svg images used as stencil maps for displacement or for layer masking,
can be very slow.

Fur
• BUG ID 35731 - Fur length textures can’t be edited with the Stretch tool.
Use different fur length drivers, such as hair guides or vector vertex maps.

General
• BUG ID 49514 - Mac OS X only: Running modo_cl before running the UI Modo application breaks
code signing.
As a workaround, start the UI version of Modo once, before running modo_cl on any system where
you later intend to use the UI version.

GL
• Windows only: Using Raptr can cause GL driver crashes in Modo.
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• BUG ID 52886 - The Draw Faded Grid option does not work correctly with X or Z up coordinate
systems.
• BUG ID 43220 - Replicated items may not be visible in GL from certain Camera or Perspective view
angles.
As a workaround, turn off GL culling using the glculling toggle command.

Input Devices
• BUG ID 51741 - Modo sometimes becomes unresponsive when using the combination of a clickdrag in a tree view (for example, when toggling the visibility of two successive items in the Shader
Tree), followed immediately by a two-finger scroll gesture on some devices, including laptop
trackpads and the Magic Mouse. As a workaround, avoid that specific combination of input events
or change to a 3-button mouse (recommended to fully access all of Modo's features).
• BUG ID 35856 - Linux only: Plugging in a Wacom tablet while Modo is running can cause undesired
movement. This cannot be fixed, due to a limitation of the hardware driver.
To avoid this, plug in the tablet before application startup or restart.

MeshFusion
• The new Fusion workflow does not accept mesh instances as source meshes.
As a workaround, convert mesh instances to meshes before adding to the Fusion Item.
• BUG ID 53543 - Some pre-10.2 Fusion items with mesh Instance sources cause Modo to crash when
converting to the new Fusion workflow.
As a workaround, convert all Fusion source mesh instances to meshes before conversion, or don’t
convert those items.

Modeling
• BUG ID 53424 - Focus (Ctrl/Cmd+A or Shift+A) does not work with morph targets when Deformers
are enabled.
As a workaround, disable the Enable Deformers setting in the 3D Viewport Properties (keyboard
shortcut: O) under Drawing and Control > Animation.

Network Rendering
• BUG ID 48325 - Scenes with image sequences rendered with Full Frames use the wrong image
sequence number on slave machines.
As a workaround, use File > Consolidate Scene, then render the scene using a shared network
folder (Preferences option under Rendering > Network Rendering).
• BUG ID 30318 - Network Rendering doesn’t support Realflow particles.
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• BUG ID 25636 - Frame passes are not supported.

Nodal Shading
• BUG ID 50642 - Nodal shading does not support UDIMs.

Painting/Sculpting
• BUG ID 41682 - Textures are not always updating in Preview/Render when painting on an image
map.
You can save and reload the image to force the update.

Particles
• BUG ID 44551 - Surface Particle Generators may not update with changes to a Density Gradient
Input set to Slope.
As a workaround, choose Distance to Locator or any other setting from the Density Gradient
Input dropdown, then change it back to Slope.
• BUG ID 34925 - Re-opening scenes saved with large particle caches can cause problems.
To avoid such issues, delete the cache before closing Modo, or export the particles to .csv cache
files or Realflow .bin files. You can do this by attaching one of those nodes to the Particle Simulation
item in the Schematic viewport, and clicking Cache Simulation.

Preview
• If a high poly mesh is not visible, the Preview baking output will be incorrect.
Reset Preview to fix the baking.

Procedurals
• BUG ID 52149 - Curve Extrude mesh operation: The Path Segment Generator's Align to Normal
option doesn't work when using a Bezier with zero-length tangents.
As a workaround, rotate the polygons to point toward the +Z before extruding or make sure there
are no zero-length tangents.
• BUG ID 49767 - Scenes which contain a UV constraint modifier driving texture properties may fail to
load after saving, due to a modifier dependency loop.
• BUG ID 46512 - When rigged, Rock items and other procedurals do not display correctly in GL. This
is a limitation of the feature and will not be fixed.
You can use Preview or RayGL to visualize the variations from rigging.
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Projections
• BUG ID 49473 - Projections are incorrect if the projecting camera is set to Vertical film fit mode and
the width is less than the height.
• BUG ID 43771 - Camera projections from non-render cameras show distortion in GL and baking.
To avoid this, make sure that the projection camera has a film width-to-height ratio that matches
the main render camera.

References
• BUG ID 44492 - If a scene that already contains references is referenced, the shading of the original
references may not survive.
As a workaround, limit scenes with shading to one level of reference.
• BUG ID 41119 - Reloading a reference after replacing it with the same file can cause Modo to crash.

Rendering
• BUG ID 53411 - Mesh Lights or any direct light too close to a surface can produce fireflies (hot
pixels) in some cases.
As a workaround, use a Maximum Radiance higher than 1 W/srm2 to reduce the bias.
• BUG ID 52730 - The Vertex Illumination Bake command is broken when the mesh has transform
channels.
As a workaround, freeze the transforms in the mesh properties.
• BUG ID 53184 - Value presets created for material Subsurface Scattering samples in Modo 10.1 or
earlier now show on the Render item instead.
• BUG ID 53151 - Saving passes as images can save the wrong alpha if the scene only has alpha
outputs in material masks.
As a workaround, make sure you have a Global Alpha Render Output in the Shader Tree.
• BUG ID 46468 - Additional (masked) alpha outputs are not saved when rendering animations.
Since other render outputs do work, a remapped depth output with a very high maximum depth
setting functions similarly to an alpha output.

Rigging
• BUG ID 27244 - Duplicating joints in a bound mesh retains influences from the original joint chain.

Scripting
• BUG ID 53458 - Right-clicking or running a script in the Script Editor can lock up input to Modo.
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As a workaround, click in the top window of the Script Editor, use the main menus, or change to
another application, then back to Modo.

Shader Tree
• BUG ID 37858 - In the Shader Tree, choosing a group from Add Layer > Image Map > (use clip
browser) fails.
To work around this issue, in the Clip Browser, choose a single image instead of the group, and
then change to the image group using the Texture Layer's Properties tab.
• BUG ID 30947 - Layer masking displacement does not work unless you drag and drop the masking
layer onto the displacement layer.

Unreal and Unity Materials
• BUG ID 50701 - Unreal material Ambient Occlusion does not bake correctly in Modo.
• BUG ID 50700 - There is no way to visualize the Unreal SubSurface Color effect in Modo.
• BUG ID 50451 - On some graphics cards, Unity material may cause flickering in the Advanced
viewport when used with bump maps and shadows.

UI
• BUG ID 44496 - Mac OS X only: Disabling Affect System Color Dialog in Preferences > Rendering
> Color Management, and using the system color picker causes colors to darken with each use of
the color picker.
This is due to an OS X issue, which requires the color profile in both the monitor settings and color
picker to be set to sRGB IEC61966-2.1.
• BUG ID 44896 - Dragging and dropping an image from the system into the Clips list doesn’t work.
If the Clips list is empty, drop the image onto the bar at the top, otherwise drop it above or below
other images in the list.
• BUG ID 43162 - Windows only: Setting a custom text size affects Modo's text drawing.
As a workaround, go to the compatibility settings by right-clicking the Modo shortcut or executable,
and turn off font-scaling for the app.

UV
• BUG ID 53468 - Transferring UVs with multiple meshes may cause Modo to crash.
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Volumes
• VDBVoxel items support OpenVDB 3.0 files or earlier and don't properly load those encoded with
Blosc.
• BUG ID 53554 - VDBVoxel items don't list Mesh in their Change Type context menu list.
As a workaround, select the VDBVoxel item and enter item.setType mesh locator in the command
prompt.

Developer Notes
Here are the changes relevant to developers.

Bug Fixes and Enhancements
• The DrawingOverride metaclass has been added.
• ILxSchematicGroup, ILxSchematicNode, ILxSchematicNodeChannel and
ILxSchematicNodeConnection have been added. ILxSchematicNodeConnection Count and
ByIndex are not fully implemented.
• The saveOK method didn't take the MSGDIALOG_NO message into account.
• ILxSceneEvalListener has been extended to add two new functions: ChannelPreValue and
ChannelPostValue. These are called before and after a series of ChannelValue calls to signal a
series of related changes.
• The ChannelTracker has been extended to pass a flags value that specifies the reason the channel
tracker is being called; Pre, Value, or Post.
• Mesh edits performed by TD SDK couldn't be undone.
• RenderCache: GeoCacheSurface_SourceItem() has been updated to return intanced items.
PrintStats has been updated to not display segment information (faster for heavy scenes) and
output more information for instanced items.
• The RenderCache documentation has been updated.
• BUG ID 41346 - Resizing a viewport sometimes caused the mesh to turn white.
• BUG ID 49913 - A specific scene caused RenderCache to crash when you changed the render camera
from Camera 2 to Camera 1.
• BUG ID 51346 - Changing dependent channels in plug-ins didn't update forms.
• BUG ID 51728 - Command blocks didn't allow message keys.
• BUG ID 52550 - item.channel notifications for vector channels are now handled by base name.
• BUG ID 52561 - RGBA map definition has been added to the TD SDK meshgeometry.
• BUG ID 52731 - Setting multiple channel values ignored the action argument.
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• BUG ID 52812 - Moving a proxy with RenderCache on caused Modo to crash.
• BUG ID 53196 - TD SDK: Setting the color channel did not work as expected.
• BUG ID 53198 - RenderCache: Drawing a Bezier curve with sdk.rcache.listen on caused Modo to
crash.
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